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For Rob, Ben and Abby

Author's Note:
| first created these tutorials in May of 2008. With this
revision, in November of 2008, | have tried to update my

screenshots as much as possible. It is hard to keep up with a
moving target.




How to set up a
Gmail account
http://mail.google.com
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1. Click to sign up for Gmail

ccccccccc

Click here to
sign up for a
Gmail account




2. Create an account - Part 1

Create an Account

Your Google Account gives you access to Gmail and other Google services. If you already have a Google Account,
you can sign in here.

Get started with Gmail Enter your name.
First name: Gz %

Last name: [pavis Choose a login name]

Desired Login Name: @gmail.com

check v Y| ChECK that it is available]
o Password strength: ~ Strong

Sl Choose a password - it must

Choose a password:

Re-enter password:

[~ Remember me on this computer be at least 8 characters.

Creating a Google Account will enable Web History. Web History is a

feature that will provide you with a more personalized experience on n
Google that includes more relevant search results and recommendations Scroll down on the page!l!
Leam More

I Enable Web History.

3. Create an account - Part 2

Security Question: [ W e oy G GGE=toR Choose a security question
W from the drop down menu

will ask T or write your own.

Learn More

Answer: ous’

Secondary email: include a secondary
email address - this is

optional

[ebleich@yahoo.com”

Location: United States |

Waord Verification: Type the Characlers you S in the picture below.

1 E Prove you are human by entering

sperspell the letters that you see.

Terms of Service: Please check the Google Account information you've entered above (feel free to
change anything you like), and review the Terms of Service bekow.

Printable Version

[coogle Terms of Service j
elcome to Googlel s
1. Your relationship with Google T
¢ RS

By clicking on 'l accept’ below you are agreeing to the Terms of Service above and

both the Program Policy and the Privacy Policy. CI k
I accept. Create my 3ccount. i | vcvlir ;ﬁf:i?taiégocgﬁ?te




4. Start using Gmail

Read your Welcome to Gmail email.

Gmail is different. Here's what you need to know. 1ncex|x
Gmail Team to me 10:01 PM (15 hours ago) Reply

Messages that are easy to find, an inbox that organizes itself, gre d

cool? Welcome to Gmail.

Helpful links to directions

To get started, you may want to:

+ Learn about some of Gmail's unigue features on the Getting Started page.

+ Follow our Switching Guide to learn how to announce your new Gmail address, im our contacts,
and forward your email from Yahoo! Mail, Qutlook, Hotmail, and others.

+ Setup vour mobile phone to get super-fast access to Gmail.

+ Visit our Help Center to find specific answers to all your questions.

Users have often told us that the mare they use Gmail, the more they discover its benefits. So go ahead and give
ita try. We'll keep working on making Gmail the best email service around, and we appreciate your joining us for
the ride.

Thanks,

The Gmail Team




How to Create a

Google Docs Account
(if you don't use Gmail)
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1. Get Started

I 1. Go to www.docs.google.com l

2. If you have a gmail
account, use that to sign
in to Google docs.

Sign in to Google Docs with your
Google Account

Email: |
Password

Remember me on this
computer.

Sign in

| cannot access my account

Don't have a Google Account? 3. If you don't have

. a gmail account, click
Get started ] get started to set up
a Google account. You
do not need a Gmail
account to create a

Google account.




2. Create an Account

4. Enter your email address

Create an Account

Your Google Account gives you access to Google Docs andother Gooagle services. If you already have a Googl
Account, you can sign in here.

Required information for Google account

Your current email address:
e.g. myname@example.com. This will be used to sign-in to your account

Choose a password: [ Password strength:
Minimum of 8 characters in length.

Re-enter password:

Remember me on this computer.

5. Choose a password o B e -
: : reating a Google Account will enable Web History. Web Histery is a
and enter it twice. It must feature that will provide you with a mere personalized experience on

be at least B characters. Google that includes more relevant search results and recommendations.
Learn More
[+ Enable Web History. 6. Scroll down on the
page.

3. Scroll down on the page.

I 7. Enter your first and last name (this is optional) I

Get started with Google Docs *

First namos (ostiona) [

Last name: (sotoral) [

Location [Gnited Staies 5
Word Verification: Type the characters you see in the picture below.
Srirad
S J;q_a'_“
8. Copy the letters
ou see here. 5
i =~ ceariped &
Terms of Service: Please check the Google Account information you've entered sbove (feel %
free to change anything you like). and review the Terms of Service below.
Printa Version
[Foogle Terma of Service c_:
[Welcome to Geeglel .
1. Your relationship with Google v
| € - &} alr

By clicking on 'l accept’ below you are agreeing to the Terms of Service
above and the Privaey Policy

| accept. Create my account
9. Click accept and
create your account.

10. You must go to your email and click on the verification link before
wyou can do anything else in Google docs. This could take a while if your
email uses a filter.

11. Once you verify your account you can start using
Google Docs.




How to Create and Share
a Google Document
http://www.docs.google.com

Created by Liz B. Davis
May 12, 2008
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1. Create a new Document

S ki
gy Document
Click on New

Ui Spreadsheet

mj Presentation |

Folder
Choose Document —

A new document will open up. The tool bar is similar to most word processors.
Mouse over each icon to see what it does.

Go =3|L.‘ Docs lizbdavis@gmail.com | Docs Home | Help | Sign out

How to te and Share a Docu

~ Share v JEE-E\ Save & close
Insert Format Tools Table

H" G v A Verdana v idpt v B|Z U Av S Lk == & E|= = =

S EEEEEE LY
How to Create and Shar‘Mogle Docs

Highlight text and click link to link the text to a Website, document, or email.




2. Adding Links

Choose what you would like to link to. And Insert the Web
address. The text should be the same text you highlighted.
A L

Dgcument Bookmark E-mail address

Link Display
Text: Gooqlé Docs
The hyper-linked text, like Click me for the best loan rates!

Flyower:
The fiyover appears when the viewer's mouse cursor is over the link

Open link in new window

_Insen__.‘ Cancel

Click insert when you are done. When you go back to the
document, the linked text will be blue.

3. Saving your document

Google Docs will automatically save and name
your document. You can use the file menu to
Rename it.

Edit Insert Format Tools Table
Mew document

= Save Ctrl+5
Save as new copy
Rename
Revision history
Delete

Download file as... >
Print settings...
=y Print... Ctrl+P

Print as webpage...
View as webpage...

N

= S
:,You can also use the file menu to download

the file as a word document and to view the
Revision History.




4. Viewing the Revision History

The revision history shows who edited the document, when the edited
the document and a little of what changed.

v Revision 311
v| Revision 309
Revision 307
Revision 305
Revision 303
Revision 301

Revision 299

« Back to editing the document

3 weeks ago by christy
3 weeks ago by Me
3 weeks ago by christy
3 weeks ago by Me
3 weeks ago by christy
3 weeks ago by Me

3 weeks ago by christy

odcast. Introduce Podcasting
http://fullmeasure.co.uk/comin
, listen and create a P Introdut
Reading: Freedman, Terry et.c
Today we will introduce Podca
no fext added

Using 21st Century Technolog

lCor’lpare Checked

Revisions 308-311
Revisions 307-309
Revisions 305-307
Revisions 303-305

Revisions 301-303

Revisions 295-301

Revisions 0-285

Check off several revisions and click on Compare Checked to see the
differences between the revisions. Click Back to editing the document
to see the differences betweent the revisions.

5. More about the Revision History

Revisions made by different
authors are color coded.

Vo

Authors:

Deleted text will be crossed out. Added text will be highlighted.

r4




6. Sharing a document (part 1)

Click on the share menu to email or
share the document with others.

Save Save &clc

2 Share with others

Email as attachment...
Send message to collaborators...

Publish as web page...

View as webh page (Preview)

/. Sharing a document (Part 2)

You can invite people as collaborators or as viewers. Collaboarators will
be able to view and edit th‘gdocument. Viewers will only be able to

view the documents,‘l"he people you share theldocument with will have
to create a GOOQEICIOCS account.

Enter email
addresses
here.

\n\me people

as collaborators " asviewers

e

Separate email adi es with commas.

Choose from contacts

Click invite -1
collaborators
when you are
done.

, Invite collaborators

Advanced permissions

[+ Collaborators may invite others
Only the owner may change this

w Invitations may be used by anyone
Allows mailing lists  Learn more

st Century Tools Syllabus cdied on May 2, 200611 P by

Save & close

This decument is currently shared.
Preview document as a viewer
View RSS feed of document changes

Collaborators (3) - remove all
Collaborators may edit thg doc
people.

ment and ipvite more

Me - owner You can see all the
Christine collaborators here.
christy

(<) Emai collaborators

2] Create event with collaborators

Viewers (0)
Viewers may see the document but not edit it.




8. Publishing your document (part 1)

When you publish a document. It becomes a Webpage. Viewers of the
Webpage do not need a Google account to see the page. Viewers may only
view, they can't edit the document.

21st Century Tools Syllabus cied ogfay 2, 2008 6:11 P by B | save

Lizbdavis Save & close

This document is not yi

You can publish your do
document will be assi

ent to the Internet, where anyone will be able to access and view it online. Your
a unigue address (URL) on google.com that you can send to your friends and

colleagues.

You can check this box to automatically update the
Publish document [~ Webpage whenever you make changes to your document.

I Automatically re-publish when changes are made

This document has not been published to your blog.

You need to set vour blog site settings before you can post documents to your blog

POSt 10 D10y |y You also have the option of using
Google Docs to publish directly to
Don't have a blog yet? Create your own with Elogger. your blOQ-

9. Publishing your document (part 2)

After you publish the document, Google Docs will give you the
Web address (URL) where you can find the document. If you
click here, you will see your document Online. ‘

This decument is published on the web. *

Your document is publicly viewable at; hitp:/docs.google.com/Doc?id=dfnmiatd 354mxppnbhd
Published on May 4, 2008 7:54 PM

Re-publish document || Stop publishing Click here to take the document
Offline.

¥ Automatically re-publish when changes are rfaoe




10. Download your document

Use the File menu to download your document.

Edit Insert

MNew document

|l Save
Save as new copy
Rename
Revision history
Delete

Download file as...

Print settings...

o Print...
Print as webpage...
View as webpage...

Format

Tools

T

le

Ctrl+8

Ctrl+P

I U A~ M.

Offline.
e ——

e here:

PDF 24

word \

HTML (zipped)

RTF
&

Text

You can download
your document in
many different
formats.

OpenOfiice




Creating and Sharing
Google Presentations.

Created by Liz B. Davis
May 4, 2008
Updated Nov. 24th, 2008
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1. Choose a Google template

Click on the presentations tab, to choose
from a list of templates.

Sort b

! All types Documents Presentations Spreadsheets Forms
» Hottest
Most users

Party Invitation Card (Reindeer Th By G
Nt e L] a. y Invitation Card (Reindeer Theme) y Google

4ratings Ratelt Embed
This party invitation card features a cute reindeer on the front. Print this card on
Narrow by category m (“Use this template ) Preview
» All categories 4 @
Albumns & Flipbooks
Business
Cards & Certificates ) Natural Elements By Google

Holiday ¥ o7ratings Ralelt Embed

Green Presentation z : . 2
Presentation Designs Template Design Two Natural elements go hand in hand with "green" topics. This design combines a ¢
natural base to showcase the message.

("Use this template ) Preview

Templates I've used

) The Machine 8y Googie
29ratings Ratelt Embed
This option dives deep "inside" technology and takes a look at the hidden movir
the dirty work so you don't have to.

("Use this template ) Preview

I =l | atituda S Eannle




2. Or Open a New Presentation

Click on New | ™ =
_g Document ™ aldi

iy Presentation A

Choose a F7} Spreadsheet
new Presentation = Farm
E

O

Folder E]
From templat g
rom tempilate... —
Or choose from a i =
list of templates. El L Allokcr O
| Items not in folders '_|
21 Cent Writing Class -
21st Century Tools (14|
n
3. The File Menu
/ Edit Slide Insert Arrange
From the File menu !
MNew »>
k Tj Pres
Open... @ Doct
You can upload Upload a presentation
a PowerPoint presentation fﬂ i You cdn
from your computer. e S save,
MNew copy of presentation rename or
Look at the revision history | reoyision “imV._—- el
Rendmn presentation
Delete presentation *--_
Download your pr'esentaﬂon 3| Download presentation as >
as a PowerPoint or PDF file (Z) Print..




4. The Edit Menu

File B= Slide Insert Arrange
slide w~ Undo IS
¥ cut From the Edit menu

Copy you can change the
/ theme or background

U selectall / / of your presentation

B Change theme /
Change background

5. The Slide Menu

File Edit Insert  Amrange

Slide 1of 1 [+] New slide

| Duplicate slide From the edit menu

bl Blese-slide you can add a slide,
. Zoomin duplicate and
« Zoom out delete slides.
Using Google




6. The Insert Menu

lide Arrange
From the Insert menu ] 1mage L3
?vou can "_'s”t fext, ¢ Video Currently only YouTube
images, video and B | Shape >

videos are supported.

shapes.

Use import slides to bring slides from one
Google presentation to another Google Presentation

7. The Arrange Menu

Bring to front Normal

Click first on an image
Send bacly K"-\, and then open the Arrange
Send to back

menu to change the layers
of your images

Bring forward




8. The Tool Bar

Insert an image

Insert a hyperlink

Add a slide Delete a slide

! Nt
nsert a text box "
Duplicate a slide Adjust the

font

1 E0OE o G T @& o Normal - 32pt B I U A+ &~ Link }= 3

Align the text

9. Revision History

New
Open...

4| Upload a presentation

|l Save
Save & close
Mew copy of presentatj
Revision history
Rename
Delete presentation

dit Slide Insert Arrange

L4

Click the file menu
and choose
Revision history

made. Click on a revision to see the history of
the presention.

The revision history shows when the presentation
was last edited, by who and what changes were

Revision / Last Edited ‘ Changes

Revision 25 2 seconds ago by Me Meodified 1 slide
Revision 24 2 minutes ago by Me Modified 1 slide
Revision 23 2 minutes ago by Me Added 1 slide, Modifie
Revision 22 3 minutes ago by Me Modified 1 slide




presentation

[ start prosentation |

S d

Click the Share menu
to share the prestentation

Share Save & close

-4 Share with others

10. Share, publish and/or email your

L3
& Publish / embed \

(] Email presentation

with others as collaborators

You can publish
your presentation
online and embed it
on a web page.

or as viewers,

You can email the
presentation to
others.

e

11. Share Presentation with Others

You can invite people as collaborators or as viewers. Collaboarators will
be able to view and edit tHe document. Viewers will only be able to
view the documents. The people you share theldocument with will have
to create a Googllﬁrdoa-‘, account.

Save

[ stare ~_|

Save & close

st Century Tools Syllabus cdizd on va

Lizbdavis

\rwl:e people

* as collaborators

This document is currently shared.
Preview document as a viewer
View RSS feed of document changes

as viewers

Enter email
addresses . .“ Collaborators (3) - remove al )
here. Collaborators may edit the document and invite m

5 = e e i e people.

Separate em sses with commas.

Choose from contacts Me - owner L You can see all the

Christi
g 1 colaborators ch;gne collaborators here.

Click invite -
collaborators
when you are
done.

(=) Email colaborators

Advanced parmisslons [&] Create event with collaborators

[« Collaborators may invite others
Only the owner may change this

Viewers (0)
Viewers may see the document but not edit it.

I Invitations may be used by anyone
Learn more

Allows mailing lists




12. Publish Presentation Online

Your presentation will be assigned
a Web address that you can share with others.

This document is published on the web.

Your d i bli i ble at:
e SR AT o Tt T . 37 §akage / How to Creating and Sharing
L d on May 4, 2008 9:39 PM . .
a Presentation using
Mini Presentation Module: 3
You can post your published presentation online for others to browse (see GOOgle PresentathnS.

demo on right). Copy and paste the code below to your clipboard and paste it
into the himl of any website or blog

<iframe
src="http://docs.google.com/EmbedSlideshow?docid=dfn
frameborder='0' width='410' height='342'></iframe>

Created by Liz B. Davis

SR May 4, 2008
smpp“hnsmngka_ This is a preview L@-_w €]
Click stop publishing to of the presentation
take your presentation
Offline. a4 pp Google Docs | Menu

Copy and paste this code
into any Website to embed
your presentation.

13. Speaker Notes

Click to add
speaker notes

Mo one else is editing this presentation

['q) Mormal ~ 20pt +B I U A~ S~ Uk ST EEEEE=E T
_-;- Speaker notes
Speaker Notes The speaker notes This is where you can add
k . ._* notes for the speaker.
sidebar will open. These will not be seen during
the presentation.
Click to add
speaker notes
T~ Click the x to close

the speaker notes.

1o ane else is edting this pressntation




14. Start the Presentation

| s ke I Share - Save &

Click here to switch to
presentation mode,

15. Take control of the presentation

This is the Web address for your
presentation

Click here to
take control

of the presentation \m“ P ——
Creating and Sharing Take control of presentation

. . View Epeaker notes
a Presentation using
Google Presentations. P

Elizabeth Davis

http:/ {docs aooale.com/Present?docid=dfn

me: If you Share the Web address of your
. 3 presentalion with others, your viewers can |
Created by Liz B. Davis participate in an Online chat while you are

May 4, 2008 presenting [

This is where you !

Click here to enter chat text
advance your slides. /
]

CGoogle Docs: |

Done




16. Take control of the presentation

Once you take control everyone can see the
slide you are on. They can follow along.

You are presenting!

Click here Everyone can see the slide you are on.
Stop presenting
to stop 4

View speaker notes
presenting \

Click here to view your notes.
They will pop up in a separate
window that only you can see.

17. Download or Print your
Presentation

Edit Slide Insert Arrange

New T | e
Open...

4| Upload a presentation n

r-Avvil

= Save Use the File menu to
SebidlRil download your presentation
Mew copy of presentation as a Pdf powe.r'poinf or txt
Revision history file
Rename *

i Delete presentation /
+| Download presentation as ( PDF
(= Print... PRT
e TXT
You can print your presentation from the

File menu.

20




18. Print Options

Print Preview

Choose the number of
slides per page. Layout:
il \'M

E Show background

[ Speaker notes

Include the
speaker notes.

Using Google Presentations

Print or save as a PDF.

¢ e

(Print )( Save as PDF... )

21




Using
Google Spreadsheets

to enter and graph data
http://docs.google.com

Created by Liz B. Davis
May 11, 2008
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1. Open a new spreadsheet and enter
your data.

J 4
Under the / & Document

New menu
choose ') Spreadsheet |
Spreadsheet /tj Presentation

A
Fruit Number
Enter your / 2 Apples 12
data 3 Bananas 18
™yh, + Orang 25

22




2. Toolbar Options

Choose the Formulas tab
to find the sum,
average, min, max and
more about your data.

Fle~ Edit Sert Formulas Revisions

Choose the Discuss
tab to chat

Online with
collaborators.

Share and/or
publish your
spreadsheet

oo § By Fomatr B £ U A F-ol- Ty B B L Alon+  Inserv | Delete~

B

tification RulesME" & Prinf ‘ ‘
¥ Wrap Te
D £ 6 H i

Click here to graph your data

X |

3. Highlight the data and choose Chart

Highlight the data

(include the column titles)

A

Number

2 Apples

3 Bananas
4 Oranges
Pineapple
6 Kiwi

B

12
18
25

Glhinose NrapText [

Chart ____ﬂ(:hart...
Gadget. ..

Set Notification RulesMEW

=
£

23




4. Enter your chart preferences.

Create chart [%]

%]
Choose the chart type =
Title the Chart
What type? ra Labels —
.L o Chart title IFavorite Fruits
04.( » - = : =
e S Areg e Haorizontal axis IFrult
Sub type Vertical axis INumber
, Label the Legend [ Onright |
axes Reverse categories [
What data? Preview
IAl ‘B6 i Favorite Fruits

Group data by " Rows * Columns

W Apgios

-

[+ Use row 1 as labels R

[ Use column A as labels Oranges
W Fincappie
o

Group data by rows or columns

; "‘*‘*e.}._,_,'

Save chart when done '\
Save chart | Cancel

5. Interact with the chart.

Double click on
a section to
see the number
and percent.




6. Publish the spreadsheet and chart.

IEW & Print | |

This document is published on the Choose the
?(U'ce’:’r- document is viewable at: Publish tab

; ; to post your
spreadsheet
and graph
Cnline.

Re-publish document | Stop publishing

Automatically re-publish when changes
are made

What parts?

| Sheet "Sheet1" only -

Subscribe B
More publishing options

25




Using Google Docs
to create a form and
collect data
http://docs.google.com

Created by Liz B. Davis
May 11, 2008
Updated, Nov. 21, 2008
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1. Open a new Form.

Go to the
MNew menu /_d Document

and choose iy Presentation

Form \_;;- ) Spreadsheet
y Form

FFFFFF

From template...




2. Enter your questions.

| Clﬁck here to add the next question ]
| dogaleDog

=k Add question / Email this form

| a]
Favorite Foods o/ give your form a title. |

lizbdavis@gmail.com | Sign out

See responses More actions

Please let us know about your favorite foods.

H Add a subtitle or a description (optional)

| This is the default first question. If you don't want ’
mi'—people to fill in their names, mouse over this drea
and click on the trash can.

Question Title | What is your favorite fruit ;{ Enter the first question I £|D ‘
Help Text Ch I -
S il ¢ [ Include help text (optional) ]

Question Type | Multiple choice

Click to drop dewn menu to choose
the type of question.

Banana

Apple
Kiwi

or add "Other”

_,)_DDM ) [ Make this a required quest & Click here to make it a required question

[leck done when you have finished setting up your form. I

3. Email your form:

Go gle lizbdavis@gmail.com | Sign out

== Add question ! mail this form| | See responses More actions
Favorite Foods Email Your Form
See response Embed your
Please let us know about your faVOTTeE TO0O0S. summary or form on a
spreadsheet Website or
edit the
confirmation
Name Send this form to others message
to:
?
CHIESEun, Choose from contacts
Help Text from: Elizabeth Davis <lizbdavis@gmail.com>
subject: Favorite Foods
Question 1 i .
Iﬁ Include form in the email
Bainia Note: the form description will always be included in the emai

Apple ("Send ) (Cancel )

Kiwi

or add "Other”

5

(Done ) [] Make this a required question

27




4. Post or embed your form online:

== Add gquestion Email this form See responses More actions

Favorite Foods

[Please let us know about your faverite foods.

Mame Embed

Paste this into your blog or website

<iframe src="http://spreadsheets.google.com/embeddedform?key=pM_ZE5BS0Sgq9ojF

What is you
Choose only|
B ("Cancel)
A:::a Copy and paste the embed code
i onfo your website.
I

What is your favorite desert

Ice cream Copy and share this link

cake

chocolate

You can view the published form here: hrt

5. Find the spreadsheet.

You will see your form in your Google Docs Home

=2
Name Folders / SI
TODAY

ders

B - Favorite Foods me
g Class - =

fmn ] . Vary
ools (14 = , Educators on Twitter me, Everyor

- . EARLIER THIS WEEK

sion (5

B ] tech workshop sign up me

EARLIER THIS MONTH
=] L&) PLN Input: Collaborative Suite Wsigele, Evi

28




6. View the results.

Click the Form menu to edit, or go to the
live form. The number in parenthesis shows
the number of responses.

View results in a spreadsheet.

Favorite Foods x K—-
File Edit View Format Insert Tools

G ey 5 % 123~ 10pt~ || B | asc Edit form T
A B Go to live form A
| Embed form...
estamp . Name
sh <+ .
2 sizadl . - R Click| here to see
1 ) Liz ¢ v Accepting responses
HRIe a summary of the

3 . Delete form

Suzie Ar responses
4 Ben Ar Send form
5
6
7
&

/. See a summary.
3res onses

Summary See complete respanses

The summary analyzes your results and
creates graphs and statistics.

Name
Liz, Suzie, Ben

What is your favorite fruit

Banana 1
Apple 2
Kiwi 0

What is your favorite desert
Ice cream 2 6
3

cake 1
chocolate 0

29




Getting Started with
Google Reader

p://docs.google.com

Created by Liz B. Davis

May 11, 2008

Updated, Nov. 21, 2008
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1. If you don't have a Gmail account

GO ‘; )gle Welcome to Google Reader

Reader

Get all your news and blogs in one place with Google Reader

Account

If you already have a gmail account
you already have a Google Reader

With Google Reader, keeping up with your faverite websites is as easy as checking your email.

o) ooogu Biog = - Gt e

Fiy me to me masn

©2008 Google - Googl

Stay up to date

Google Reader constantly checks your
favorite news sites and blogs for new
content.

Share with your friends

Use Google Reader's built-in public page to
easily share interesting items with your
friends and family.

Use it anywhere, for free

Google Reader is totally free and works in
most modern browsers, without any
software to install.

Take atour»

Sign in to GoMle Reader with your
Google Account
Email:|

Password:

] Remember me on this

computer.
("Signin )

| cannot access my account

Don't have a Google Account?

Create an account

If you don't have a 6mail
account, click here to create

email address,

a Google account using a different

30




2. Create an Account (part 1)

4. Enter your email address

Create an Account

Your Google Account gives you access to Google Docs andother Gooagle services. If you already have a Googl
Account, you can sign in here.

Required information for Google account

Your current email address:
e.g. myname@example.com. This will be used to sign-in to your account

Choose a password: [ Password strength:
Minimum of 8 characters in length.

Re-enter password:

Remember me on this computer.

5. Choose a password o B e -
: : reating a Google Account will enable Web History. Web Histery is a
and enter it twice. It must feature that will provide you with a mere personalized experience on

be at least B characters. Google that includes more relevant search results and recommendations.
Learn More
[+ Enable Web History. 6. Scroll down on the
page.

3. Scroll down on the page.

I 7. Enter your first and last name (this is optional) I

Get started with Google Docs *

First namos (ostiona) [

Last name: (sotoral) [

Location [Gnited Staies 5
Word Verification: Type the characters you see in the picture below.
Srirad
S J;q_a'_“
8. Copy the letters
ou see here. 5
i =~ ceariped &
Terms of Service: Please check the Google Account information you've entered sbove (feel %
free to change anything you like). and review the Terms of Service below.
Printa Version
[Foogle Terma of Service c_:
[Welcome to Geeglel .
1. Your relationship with Google v
| € - &} alr

By clicking on 'l accept’ below you are agreeing to the Terms of Service
above and the Privaey Policy

| accept. Create my account
9. Click accept and
create your account.

10. You must go to your email and click on the verification link before
wyou can do anything else in Google docs. This could take a while if your
email uses a filter.

11. Once you verify your account you can start using
Google Docs.
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4. If you have a Gmail account

4| Facebo... || ¥? (182 wun.. || ¥ Gmail: E 253 unr..l ||

Twitter ...

(nrt:hive‘] GF{epm‘t Spam j [ Deletaj
[

If you already have a

Gmail account, click here

to go te your Google Reader
Account,

(Mark as read )
, Unstarred
un-read  RE
un-read  RE
un-read Wk
un-read = OF
un-read Wit

5. Add Subscriptions

Mail Calendar Documents Photos Reader Web more v Loading...
Google Reader Alitems + (Search)
Home Welcome to Google Reader!
Starred items ¥ Click here With Google Reader, keeping up with your favorite websites is as easy
Trends for some
© Your stuff suggested
Shared items feeds
Notes

Eriends' shared items
Sharing seijiRqgs »

EAdd subscription Discover »
Show: updated - all Refresh

> @

Google Reader in Plain English

Click here to paste in the SR0ionh 24 9

Web address of your favorite

blogs and other feeds. Add some subscriptions.

Search for feeds by keyword {i.e. "CNN") or URL (i.e.
example.com) using the "Add Subscription” box.

Browse for feeds using bundles & recommendations on
the "Discover" page.

ebleich@yahoo.com | Settings | My Account | Help | Sign

Watch the video for more information
about how to use Google Reader

websites.

Share with friends
Easily share and comment on interesting
articles.

Use it anywhere
Works in modern browsers and phones.

Top Recommendations Viewall »

Cool Cat Teacher Blog
Teachin with new tools, enthusiasm, and belief that

chbowl
velopment blog for Arapahoe High School teachers

NN AR

32




6. Add Subscriptions

Click here in Firefox to add a feed to Google Reader

LML ety

= (Cli

rer.blogspet.com/

Tube MNews~ Popular~ Virtual EM5 Belmont H hool Read Later

If you see this symbol in the Web address bar,
you can subscribe to the Website.

Click on links like this to
add a Website o Google
Reader

SHMM.H.M‘*//

—= Subscribe to this feed using | § Google

|:]

w "1 Always use Google to subscribe to feeds.

e ; b1
Subscribe Now

X

Click to subscribe to the feed.

7. Options

Home
Star items you All items (1000+)
want to come Starred items ¥y
back to. Trends
= Your stuff

® Friends’ shared items (48)

Add people with
whom you want

Sharing seftings » to share your stuff,
EJAdd subscription Discover »
Refresh

Show: updated - all

Only Chasing Safety

Choose how you \

want your list Options ¥ Manage subscriptions »

)

Click here to tag your
A feeds and organize
your subscriptions into

sorted -

\ folders.
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8. Manage Subscriptions

Organize your folders

and Tags
Seﬂings « Back to Google’ der
Preferences Subscriptions Folders and Tags Goodies Import/Export
Select: All 195 subscriptions, None, Unassigned | More actio T

[ 21st Century Collaborative

@®

2¢ Worth

Add Google Reader

1 fo your homepage,

put Reader in a bookmark,
and more

Unsubscribe,

rename or delete

v Unsubscrb/ \

Rename

Rename

Rename

Banama

Organize your subscriptions
into folders

Filter by name, tag, or URL

Change folders... -

Change folders... >

Change folders... >

ed-tech
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Getting Started with
Twitter
http://www.twitter.com

Created by Liz B. Davis
Nov. 21, 2008

@00

1. Join Twitter:

Select Language ... ~|

What is Twitter?

Please sign in

user name or email address:

password:

[ remember me Sign In »

Forgot password? Click here.

Twitter is a service for friends, family, and co-workers i :

3 ready using rwluc_f from
to communicate and stay connected through the your phone? Click here
exchange of quick, frequent answers to one simple

question: What are you doing?
Click here to set up your
( Twitter account,
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2. Set up username and password:

Choose a username - I suggest using your own name in some form.
Peaple will get to know you by your username and will refer te you
that way, so choose carefully.

Create a Free I witter Account/ Already a member?

Please Sign In!

Already use Twitter on your
phone? Head over here and
we'll get you signed up on

username: | lizbdavis
£ the web.

Userna

Password:

Direct messages will be sent to
the email you choose (you can
turn off that setting).

Email Address:

Humanness:

expects

Type the two words:

Prove you are human l

Ea PADTALL

| want the inside scoop—please send me email updates!

hat you are over 13 years

| accept. Create my accoun %
k‘\ click to create your account

3. Find people you know:

Are your friends on Twitter?

B Email Security
We don't store your
login, your password is

Search Web Email (Hotmail, Yahoo, Gmail, Etc.)

Your Email @ Select... 7|
submitted securely, and
Erhail Pa i we don't email without
your permission.
continue »

Search your email for friends

who are already on Twitter. k
Click here to skip this step.
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4. Select people to follow

You can skip this _.

st " &

71 people from your address book are using Twitter!

Select people from your address book
to start following conrinue ”\ Click to continue

Select All

ISA

5. Invite people to Twitter

You can skip this step

Add people to Twitter

send invites

O select All

| B,

0 ab = tErtOWIn any e nas 33
o .

= Laae You can invite people from your [~

B " g . e - O >

— Aarer -l gddress book to join Twitter it

O Aaren . o cast.net>

| I — aaabl- 7

M adamd ¥ endamAilihactammhan ~ams
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6. Introduce yourself and manage your
account.

Manage your account, Home Profile Find Peo Settings Help Sign out

add a profile picture and

adjust your settings.

What are you doirtgr E lizbleich
0

Technology teacher getting to know Twitter

o 0

\ following = followers = updates
B - x update
Write something to introduce yourself fiome
:% What to do now: Click update to @Replies
1. Tell us what you're doing in the box abg| Pest your Tweet 7
: ; Z Direct Messages 1]
2. Find some friends and follow what they’'re doing
3. Turn on your mobile phone to update your friends on the el
go
Everyone
= Following add

Device Updates
Set up SMS updates

/. Add a profile photo:

Home Profile Find People Settings Help Sign out

o Click here to upload a photo or kiR
a ] 0 0
Photo icon. This is important because it following = followers updates
\ is how people recognize you when you
Tweet something. updstEs
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8. Adjust your account settings:

Home w felp Sign o
. . [ Adjust your account settings I
ﬁ lizbleich Account
From here you can change
= your basic account info, fill in
Account “™ Password | Devices  Notices | Picture | Design S R e
whether you want to be
Enter your real me: |Liz Davis private or public.
name here, so people en gl 8 can recogniz Tips
can refer to you bY t w1 /lizbleich = Filling in your profile
information will help
name. people find you on
Twitter. For example,
Email: |10 you'll be more likely to
turn up in a Twitter search
if you've added your
Time Zone: (GMT-06:00) Central Time (US & Canada) ~| location or your real name.
= Change your Twitter user
Add your blog or  |ifo URL rechpower.blogspor.com name anytime without
web page address ! mepage or a
After changing it, make
One Line Bio: ol outside of Boston, MA sure to let your followers
know so you'll continue
@ 1 receiving all of your
Describe what you messages with your new
. s user name.
do. This is REALLY 5 .
. = Protect your profile to
important to do before ; keep your Twitter updates
i private. Approve who can
you start I°°kmg for = follow you and keep your
followers. People like = - = - updates out of search
to know ::o you are - *———"—* You can choose to protect your updates, so
Protect my updates B —
before they agree to i that only your followers can see them. This isn't
follow you. aublid a great idea when you first start looking for

followers.

Click Save when you are done |

9. Adjust your device settings:

You can set up your cell phone to receive Tweets

Account Password Devices otices icture

Twitter is more fun when used through your maobile pho.

Mobile Phone

Please precede your number with a "+
leading 0 of your number if applic:
+12125551212. Need help?

Save

. Set yours up!

Design

nd your country code (leaving off the
). Examples: +447781488126 or

Oirs okay for Twitter to send txt messages to my phone. Standard rates apply.

39




10. Adjust your Notices settings:

Account Password Devices Notices Picture Design

=)
= ) Nudge me if | haven't updated in 24 hours
I like to know when I have Juuto Nudge:

This will send a txt to your phone,
new followers, so T

can follow them back. Replies: Show me | all @ replies

Change this to all @ replies,
New Follower Emails: ™ Email when someane starts following me 50 you will 921‘ all of your
replies (doesn't apply if your
Tweets are protected).

Direct Text Emails: E_W Email when | receive a new direct message

=)
% siftter: | | want the inside scoop—please send me email updates!
I like to know when

I get a DM (direct message) Save
N Click Save when you are done.

© 2008 Twitter About Us Contact Blog Status Downloads APl Search Help Jo

11. Adjust your design settings:

AuUInE  TIUnE TN reupie

EHEl |jzbleich

0

f

Account Password Devices Notices Picture |

[

Select a theme » I

p

You can change 2

the design on your a

Twitter page by using 4|

one of the readymade 4
themes, or uploading

your own image.

Change background image » hange design colors »

cancel save changes
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12. Search for topics or people:

Click on Search at
the bottom of the Dev

page

)8 Twitter About Us Contact EBlog Status Downloads felp Jobs

See what's happening — right now.

Search a topic, keyword or

username. | emgbearch )

Choose advanced
search for a more

13. Advanced Search:

Advanced Search

Use this form to automatically construct your query. (Aliernatively, you can type search aperators directly
box.)

Find tweets based on...

Words All of these words

This exact phrase

Any of these words

Nene of these words
This hashtag

Writien in [ Any Language 84 (oer

People From this person
To this person

Referencing this person

Places Near this place

Within this distance (15 %] @ mies O kilometers
Dates Since this date

Until this date B

Attitudes  With positive atfitude 1} [

With nanatia atitnds 4
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14. Download a Twitter Client

Twitter clients like TweetDeck update every few minutes and can
run in the background while you do other things.

TweetDeck (= el ]=]+]4]:] remaining APt 97/100 Resets: 1310 [N [0 [

All Tweets 20 Replies B Group:friends

@jepcke It was my pleasure. Thanks for
letting me share. 3 thanks to @smeech for

the invite too

when will we have themes for Google izbdavis using Dell today but the layer
Reader then? Can't be a giant leap from . oes work for me here, using both the 3D
gmail? 2 buildings and Ancient Rome 3D layer, sorry
not more help
[+ Fri 21 Ne T K ¢ 1T

@mrsbrowndog Il talk with you re: clothing
donations. @svanetten's kids will let me
know how they want to handle. So fun!

1F
kstevens77 How extensively are you using izbdavis I'l see you in Hall's 11:10 session,

Google Docs? What percentage of your £ then
work are you doing on it? Just curious. |

Last Updated: 12:10 with 200 tweets / next update 12:12 Twitter Status: Pretty much ok

Name Elizabeth Davis

Check out Bios - If Location Watertown, MA
Web http:/ jwww.edtech...

lizbdavis -
you like the bio, check Bio | am an educator who %
AL 1 strongly believes in the

out that person's followers. Do PR
member of Classrom2.0 on

About to do my MassCUL preso. Not Hiag
streaming :( But wish us luck resource b s M i
here http://www.lizbdavis.com

Updates
@robinellis | can't get the Ancient Rome layer to work on my mac. - -
Any suggestions? . avorites
@bknittle Hi Beth - Yes I'm here in Hall's session (saw you earlier .
remember?) | Following

| might just be an (should it be a or an?) @halldavidson groupie
today.

Waiting for @halldavidson to start his f < =
#MassCUE Click here to view all of

my followers, then decide

@vvrotny Awesome. | just blogged abol
http: / /tinyurl.com/60jo2x whether or not you want to

o~
En @edtechworkshop http://tinyurl.com/{§ follow them too. \“n t.a[‘

View All...

@edtechworkshop Just did a big project with Scratch
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Getting Started with
Wikispaces
http://www.wikispaces.com

Created by Liz B. Davis

May 16, 2008

Updated Nov. 21, 2008

@00

1. Sign up for an Educator account

Click the K-12 education link below to get
a free space for teachers.

> wikispaces

wikis for everyone

Don't fill this
out on this

page.

can edit together

gurs - Pricing - Private Label
QOver 1,500,

Since 2006, We've given
away over 100,000 wikis
for K-12 education!

Create simple web pages
that groups, friends, & families

00 members and 600,000 wikis!

Already a member? Sign in

oin Now!
1.Rick a username

2. Set ydyr password

4. Spacgfhame (optional

Jwikispachs.com

Tgfms of Use

Private Label

Wikispaces for your Non-Profit
Simple. Secure. Hosted.
Learn More >
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2. Join and create your ad-free space

[ Choose a username

and create a password, I

Join Now

Fill in the fields below and you're done,

1. Username

lizbdavis ‘

2. Password

3. Email Address

4. Make a Space?

Include your email
address, in case you
forget your password.

Give your space a name - it will

S g e \ become part of the URL (Web address)

Chose your privacy setting I

Choose no if lame
you just want e
to join and don't want Sibility @ Public (free)
to make a wikispace e e
_ Protected (free)
Everyone can view page: TS o
" Private (free for educators otherwise $5/month)
Only space mem| n view and
7. Educational Use T | certify this space will be used for K-12 edugation.

Terms of Use

Certify that you are using this
space for K-12 education

Click Joi

n to create your space

3. Learn more about Wikispaces.

The Getting Started Help Menu will pep up. I

Home /
~ | Getting Started With Your Wiki

Welcome to o
Welcome to Your New Wiki
Getting Startq

To get started,

About This S  Editing Your Home Page
Your space is e] * Infroduction to Your Space

Here we will acquaint you with Wikispaces and show yol how to get started. You can close this box to return to your space, and you can
find this information again by clicking the "Help" link at the top right of any page. Once you are finished with this tutorial, you can get rid of
top of every pa "Getting Started” permanently, by clicking here or on the link at the top of this screen

ool o e « Becoming Familiar with Your Space
« Managing Your User Account
Need Help? * Inviting Members to Your Space

Use these links to learn more about
using Wikispaces.

« Some Advanced Features
* More on Wikispaces and Wikis

For more inform|

Contact Us

Get More Help
If you need helg

» Click here to visit our complete help section,

Skip Getting Started (%]

Click here to close this window,
and turn off this feature.

* Watch our video tours.
« Contact us at help@wikispaces.com.

Watch the screencast videos for help getting started.
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4. Your Website

The Web address foryour Wikispace
will look like this

4

@ hup://mrslizdavis.wikispaces.com/ v

IYou will be taken to your Websitel

Click to Edit the page
\

Actions
o New Page "> home |. EditThis Page page - discussion
"™ Recent Changes
.7 Manage Space Welcome to the mrslizdavis space
|Search = Getting Started
Navigation To get started, click on the 'edit' link above to add content to
Home 'discussion’ link at the top of every page.

5. The Editing Toolbar:

I The Wikispaces editing toolbar will open l

additables editing the-ga_g_e_.

add widgets like calendars and video players ]
add or'remove hyperlinks savewhen you aredone

* Editon 1

isp

— —- T . = = . 1 1 | |
I B I U A |Normal 'I} f=. a= e s 3] 0 & _Text Editor | Preview | Save |Cancel

A

Type in the content of your new page here. ‘
[ad_d pictures and|files ]

| preview what your page will look like. |

45




6. Create a New Page

Click New Page to create a

New Page.
Enter the name of'the New Page, this |
will become part: of the Web address
for this page, and will appear in the || N Mo Sy
page menu |Search =3
Mavigation
Make a New Page Home

adit navigation
Enter the name of you page

Your new page will be created at:

http:/imrslizdavis. wikispaces.com/
) You will see the page name
_Create |or Cancel in the navigation menu fer the
Wikispace.
Navigation
Home
Homework

edit navigation

7. Upload a document  [Gocms wonw woss s e

(.dog, mp3, .moy, pdf, ppt ete.)

Images & Files 1 ditor

e EEO S E

Page: 1
Jump: ABCDEFGHIJKLMNOPQRSTUVWXYZ

The files will appear

here when they are

uploaded. Double click
TR on the file to insert it

Double dlicking a fle:_ into the page

¥ links to the file

Browse for-the [
file and

Upload it'to Upload New Fi
Wikispaces. s

sers/lizdavis/Document Browse...

The file
will look Homework | Edit This Page | | page
like this Here are the handouts for your homework
afteryou
savethe March 24th, 2008
page 7 Principles

IR

= 7Principles_CoP.pdf

46




8. Create Links

Click on the link icon

\ Editor

Hon B £ U A |Normal = iE e EEOS R

Here are the han tte:/ fm

vis.wikispaces.co

March 24th, 2001 [ Add Link =
e Link Text [Homework Cancal

[[file:7Principles

Highlight the name of the page .
o D o, Go0GT * Wiki Link Click
\ - Space |mrslizdavis OK when
I VI
Homework you are
bd! done

| Choose the page name

Choose Wiki Link from the drop down menu

" External Link

Address

-

Optional: a note

Done

Optignal-tage f

AY
To link to another Webpage enter the Web address here

9. Manage your space

I Click here to manage your space

= LT
Actions

o New Page About

Racent Cliges Created Nov 21, 2008 by | ebleich?

_,# Manage Space 0 i = ebleich2

Search =2 Members no members
s License No License

R Subscription This space is currently on our Plus plan. Upgrade Here

A
=¥ Import
Blog Post

fontent Uplead or delete files
Lock or \
delete Pages Files Templates \tT‘ Tags
pages
People
Manage the - o Invite people to join.
members of Members LS ] Perm-ssuaﬂs - | Tnvite People
your space. IChu the privacy settings. l
Settings sl P 14 g
b @ inti i 2 i i
£F " Look and Feel Subscription Wiki Info \_.'i Domain Name X] Delete Wiki
Change the / * » B
template Tools
'IJ- Notifications E—| ‘Wiki Statisti Space Usage 9 Badges D% Web Folders

(WebDAV)
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10. People can request to join the

space:

2. Direct people to
the Website of your
Wikispace and have
them click Join this
Space. If your space
is protected you

will get an email
with the request. You
can click the link in
your email to

accept or reject the
request.

-

A 3 : :
% mrslizdavis

ctions

£, Join this Space
“~ Recent Changes
_;f Manage Space

|Search =
MNavigation

Home
Homework

11. Wikispaces will add members

If you don't want your students to have to create accounts
themselves, just email help@wikispaces.com with a list of
usernames, email addresses (if you have them - if you don't
just leave them out), and passwords in the following format

and we'll create the accounts for you.

user1,email1@address.com,password1
user2,email2@address.com,password2
user3,email3@address.com,password3
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12. Wikispaces suggestions:

Usernames

We have a large number of accounts on Wikispaces, so many combinations
of first names, last names, and initials are already taken. It's much more
likely we can make all the accounts you ask if you add a school identifier to
your students' usernames. For example, if your school is called John Smith
High, instead of asking us for the usernames, adam, james, and dom, we
recommend jsh-adam, jsh-james, and jsh-dom .

Length of Usernames and Passwords
Please make sure that usernames are at least 3 characters long (we allow
letters, numbers, underscores _, or dashes -) and that passwords are at

least 6 characters long.

Which Space?

Finally, make sure to let us know which spaces we should add them to as
members.
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Getting Started with
Del.cio.us
http://www.delicious.com

Created by Liz B. Davis
May 12, 2008
updated Oct 1. 2008

@00

1. Create an account on Del.icio.us

J delicious

Your bookmarks will organize themselves. Click Join Now

Tag your bookmarks. Collections will naturally emerge.
to set up your

m B ..
" an l"l delicious account |1
Search the biggest collection of bookmarks in [5eacr Dercions
the universe...

Popular Bookmarks

The most popular bookmarks on Delicious right now

See more Popular bookmarks Q ﬂnn
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2. Choose a user name and password

& All fields are required

First name | (]
Last hame (]
Emalil Address (%]
.| Sign up for an

User name o account.
Password o
Retype Password [+ ]
Please type the letters ]

below

) (W

If you require assistance with registration our

support team can help you. #____-- Check the Terms Of Service

! I have read and agree to the Terms of Service (]

| Click here to Register

3. Import your existing bookmarks

B Import Existing Bookmarks

Skip this step if you \
don't want to import

0 Impartyourexisting haokmarks your existing bookmarks.

Bring your existing collection of bookmarks into Delicious with our handy Import feature. Select "Easy Import” to Import your bookmarks with
a single click, or select "Custom Import” if you'd like more control over how they're imported.

Automatically import your old bookmarks {recommended)

@ Easy Import
_ Custom import

| Import your existing browser bookmarks,
By default imported bookmarks are private.

M Email me when my impi

Choose custom import if you would like to
add tags or import them as public bookmarks.

If you have an old bookmark file you need 1o use our Manual Import
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4. Add browser buttons

Click here to install the del.icio.us buttons on your browser, then restart your
browser.

“My del.icio.us” butten “Tag this” button

Install ension Now » (Firefox 1.07 or newer required)

install the buttons.

You may have to edit your
options to allow del.icio.us to

If you see this message at the top of the page, click “Edit Options,” "Allow,” *Close,” and click the install link again.

i To protect your computer, Firefox prevented this site {del.icio.us) from instaling software on your computer, Edit Options. ..

After installing, please restart Firefox. You'll be automatically taken to step 3.

Not using Firefox? View alternate instructions for: Internet Explorer, Safari, Opera, or other. \

If you are not able
to install the buttons,
click here for the
bookmarklets

Quit/Exit and reOpen your browser when you are done.

5. Check your email to activate your
account. Look in your bulk mail, if you
don't see a message in your inbox.

Look for the activation email, to verify your
account on del.icio.us

noreply@yahoo-inc. 11:35 AM (9 minutes ago) Rep

¥

Hello,
Click here to activate your account.
Thanks for r

Please activate your account by going to: /
htt, el.icio.ushverifyitsprofdev/ci 9cbfESbEficfbd

If you have any questions or problems, please visit our help section. It
contains information on what we do and how to solve commaon problems.

You may view del.icio.us help by going to:
http:ifdel.icio.us/help/
For support inguiries, please visit our support page:

http:ifdel.icio.us/help/contact

Please note: this is an automated email, do not reply to this message
Instead, use the contact link listed above for any inquiries or suggestions.

Thanks!

del.icio.us team
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6. If you can't download the buttons,
add the browser bookmarkletts to your
bookmark toolbar.

del.icio.us / help / buttons

your bookmarks | your network | subscriptions | links for you | post logged in as tsg

What are buttons and why do | need them?

Buttons (bookmarklets) are links you add to your browser's Boockmarks Teolbar. They are an easy way
to post and view your bookmarks in del.icio.us.

¥} del.icio.us/doc/bookmarklets - Mozilla Firefox

File Edit View Go Bookmarks Tools Help

- P> 0B

m" my del.icio.us [] post to del.icio.us

http://del.icio.us/doc/bookmarklets

Drag both of these buttons to your browser
What do they do? bookmark toolbar

The -. post to del.icio.us n allows you to post your current page to del.icio.us.
The -. my delicic.us button allows you to quickly view your bookmarks.

How do | get them?

» Make sure the "Bookmarks Toolbar" is checked under View — Toolbars.
» Drag this link: post to del.icio.us up to your Bookmarks Toolbar.

» Drag this link: my del.

io.us up to your Bookmarks Toolbar.

/. Tag and describe Websites.

& http:/ fwww._2 1steenturyskills.org/route2 1/index.] ¥ | |(.-|‘ Ge Q

B = A = = =
@ 9 & Ol =} ogi
PowerTeacher TinyURL! blog stats WHS WEDS] itter  Diigolet Share on Tumblr tumbl'n teachers Read Later to read edutagger

When you find a website you want to bookmark. Click here
Google to tag it. k @ ser

S del.icio.us /verify

| This box will pop up. You can add notes and tags to describe the Website.
Tags must be one word - no spaces. You can use periods, dashes or
underscores. Separate each tag with a space.

Century Skills is pleased to offer Route 21. 2

what'snew n o icio.us - lizbdavis' bookmarks on del.icio.u

1 The Partnershin for 21
) ht i

~

NEWS &
ANNOUNCEMENTS .. del.icio.us
resources

recently added url |http: / /www.2 1stcenturyskills.orgf route2 1/inde: I de notsnare
257E members E M / k

description Welcome to Route 21 / /
great resource on 215t century skils Click this box to keep
“°‘esr the bookmark private
tags Fle::enluwskllls education web2.0 resources edtech tsp (Only you can see It)
save originaly posted on 2008-05-11. deleto this post. .

-

Click save when you are done.
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8. The social part of social

bookmarking.

After you add a bookmark, click here to see
others who have also bookmarked that Website

an/pdf Object)

comp-aps article

| & Text Message Reminders. Hands-free Email &

tool

encyclopedia

tecMg

tools  242sday

9. Exploring other people's bookmarks.

Click here to see the notes
people have written about
the Website

N

Click here fo see the people in
your network who have also
bookmarked that site.

—

S WeDZLU  24zs08y

m ‘ / 15 a meml

ber of your Network.

=
Everyone's bookmarks for this web page

[ techedknow web2.0  productivity

F otto12

F modernd alluway\

jott messaging voice text chat

web2.0 productivity

tools phone

communication

You will be able to see who else has bookmarked that site and what tags they have used.

n" delicious [T [ Togs |

Greg Smith (techedknow)'s Bookmarks
Bookmarks | Network | Tags | Subscriptions
Site: http://www.techedknow. com

See more bookmarks in Pepular or Recent.

Click here to add them
to your network.

Bookmarks
Click on the person's user name to see his or her other bookmarks. ]

M Save a new bookmark
¢ Network

Tags
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10. Sharing your links with others.

a

to read edutagger

PowerTeacher TinyURL! blog stats WHS WEbsite Twitter Diigolet Share on Tumblir tumbl'n

b - ¢ it B G W $ L_‘j ™ hitp: //del.icio.us/lizbdavis jweb2 .0 v
Nad Later

[[* i Diigo ~
Google | Share all of your links on a particuluar topic by giving out the Webaddress for e
—— that tag. You can see all of my Web 2.0 links by going to = ]
8 Google ... I http://del.icio.us/lizbdavis/web2.0 @ Google D...
|able
del.icio.us / lizbdavis / web2.0 / =
your bookmarks | your network | subscriptions | links for you | post logged in as lizbdavis | settings | logout | help
Your items tagged web2.0 (create tag description) — view all, popular | del.icio.us vj search
wearller|later»  showing all 76 items related tags Web2.0
Web 2.0 for the Classroom Teacher +21stcenturyskills 40 podcasting
+ 2forTuesday 76 web2.0
wel o Route 21 + article 15 wiki
elcome to Route
ity studygroup

A great resource on 2 1st century skills + blogging

4
2
2
1
4
2 +blogs
B
1
1
2
1
2

©

blogs
+ bookmarks

+ brainstorming 5 i
+ collaborate tag options
+ collaboration

+ CommonCraft
+ community

Web 2.0 | EDUCAUSE CONNECT [Term View]

=

view as cloud | list
sortby alpha | freq

nea minimum 4 2 &

=

Web 2.0 - FETC Version

2
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Getting Started with
Diigo
Setting up your accoun
http.//www.diigo.com

Created by Liz B. Davis
May 12, 2008
updated Nov 21, 2008

@08

1. Create your Diigo account.

Research and Collaborate

5 ow you can highli
Watch the video to learn more | o i weoen

b all your research)
» Don't just bookmark! Highlight the ! Add notes too! n
LSS Hishisht tha ol stchyineh : about what Diigo can do.

+ Access and search your findings from any PC or iphonel! —
everyone to view
Create groups to pool resources for specific projects.

Connect and Discover

you belong tq

Easily sxtract and complls all your Fighlights across multiple pages
‘You are what you annolate, creating a presence for you in the community. Annotate webf i-i inline stic

Connect with friends effortlessly and non-intrusively through content.

. . . " - Inline Comment|
Discover quality resources on any subject or get personalized recommendations. R e e

Learn More »

Click to create ¢ [fun with friends,
free Diigo account

tive with Diigo... DEMO

\ . : £ TechCrunch

Top 10 Research Tools”
@ea

Already have a Diigo or openid account?

Ao} Click here te learn more about
signing up for an educator account
_\\_‘éfi‘ Educator Accounts - a free premium account especially designed for educators. | /_
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2. Choose a username and password.

Create your account sign In

Choose a Usermname

First name Last name

Retype Password

|99I|5 | For ant-spam, please type this number in the box
provided (Cannot read? Try a different one )

i me the occasional site update and tip. You can unsubscribe atany time

Continue

3. Set up your profile.

Set up your profile on Diigo.
Avatar

Upload Image

You can upload a JPG or BMP file. (Max 2M)

Do net uplead a photo containing celebrities, nudity, or copyrighted image.

_ Browse

Upload

Basic Information

Username: tomsnyder

RealName: Tom Snyder

Gender:

Birthday: [Month: ~|[Day: x| [Year =]
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4. Find friends on Diigo or skip this

step.

Find Your Friends

Diigo will look

who already

have accounts on Diigo

through your email Your Email:
contacts for people

Email pass 1:

Click to find your

Friends /

Step 3 (Add Friends)

Find out which of your email contacts are on Diigo.

tsprofdev " @/ gmail.com M|

You can skip this step and
look for friends other ways

\Ski .

Find Your Friends

5. Before you click Add to friends, scroll
down on the page. Clear the check
boxes and check off the people to
whom you would like to send an
invitation.

Add Friends

=

=

On Diigo

You've got friends
choose the people you want to]

Step 3 (Add Friends)

Before you add any friends, first click
Clear All, then scroll down and choose the
friends you want to add or invite to Diigo.

Click add to friends when
you are done. §Saieciaii ] M clearall]

e
=

L

|
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6. Check for your activation email. Look
in your bulk folder if you don't see it in
your inbox. Click to resend if you don't
receive it.

Before you can start using Diigo, you have to activate your account.
Check your email and verify your account. If you don't get the email
Click to resend it and try again.

Please activate your acount

Dear Tomsnyder. Your account has been created.
We've sent you an email to tsprofdev@gmail.com to verify your account.
Please look up the email and click the link there to activate your account.

Didn't Get the Email?

First, be patient, sometimes it takes a while for the email to

Resend verification email

Check above to ensure yo
below and resen

u entered your ema
email

= Check your junk email box, the message m

[ts profdev@gmail.com " Resend email

= Contact us if you work.

7. Follow the steps to install the Diigo
Toolbar.

Please follow these steps:

1. Click the "Install Diigo Toolbar” button below.

2. Click "Edit Options™ at the top-right of your screen and your
browser will open a panel. Click "Allow™, and close this panel.
3. Click the "Install Dilgo Toolbar" button below again, and then
click "Install”.

4. Restart your browser.

Follow these
instructions to
install the Diigo
Toolbar.

Click the button above to install in seconds!
Fully customizable to save desktop space

No adware or spamware!

Power tools to substantially enhance your experience
for online browsing and interactions,
and for information gathering and sharing...
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8. Import your browser bookmarks to
Diigo - you will now be able to get to
them from any computer. You can also

import your del.icio.us bookmarks to
Diigo.

Import bookmarks from your browser and/or del.icio.us

You don't have any bookmarks ye/

Impart bookma

) your browser | * del |c|'o us ‘

9. Click on the Tools link at the bottom
of the Webpage (it is at the bottom of
all Diigo pages).

Click on Tools at the very bottom of the page.

About Diige Help UserFoum Blog Tools Contact What's New
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10. If you can't download the toolbar,
you can add diigo browser buttons.
Click on Digolet and drag the
appropriate link

to your bookmark toolbar.

If you can't download and install the toolbar use the Diigolet. Drag the appropriate Diigolet to your Links Toolbar

Diigo Toolbar Diigolet
» Diigolet Diigolet is not as feature-rich g€ the Diigoftcolbar, bufWgan be set-up by simple drag-and-drop - no
i i
Enhanced Linkrolls download or installation wsers. Much more powerful than
bookmarklets offered is a "super bookmarklet” that allows
[ogoke you to highlight an
Send to Blog
Daily Blog Post @ Diigolet (3 Diigolet © Dilgolet  Dilgolet & Dilgolet (2 Diigolet
Import Bookmarks for Firefox for Flock for Safari for Opera for Internet Explorer for Maxthen
Export Bookmarks
"Add to Diigo” Widget Set-up

11. If you want to add bookmarks to
Diigo and Del.icio.us simultaneously
click on Tools at the bottom of the page
and choose Save Elsewhere.

Click Save Elsewhere to simultaneously add bookmarks to both Diigo and other services such as del.icio.us

Save Elsewhere

Diigo Toolbar

"Save Elsewhere" allows you to simultaneouslk add your new bookmarks to other services you set up here.

Diigolet
1) Select the service ~ 2) Input your account infmation
Enhanced Linkrolls

3) Check the account to make sure itis valid 4)gave
=

Tagrols After you set up your accounts here, all new bookMarks you add using Diigo Toolbar 3.0 or later are automatically

Send to Blog posted to these other websites.

Daily Blog Post Username Password

Import Bookmglfks ~ Delicio.us [ 1 ‘ Validate acccount

Export Bookrfrks

R i ~ Magnolia ‘ i ‘ Validate acccount
P Save Elsewhere I Simpy ‘ ‘ Validate acccount

Install Facebook App s i
ave |

Diigo API
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12. Sign up for an educator's account:

@gulnr account and then apply for an Educ@

What are Diigo Educator Accounts?

These a¥g special premium accounts provided specifically to K-12 & hig
applicatiol is approved, your account will be upgraded to have these addtional features:

r-ed educators. Once your Diigo Educator

Ads presented to sf§gdent account users are limited to education-related spongprs.

Learn More »

If you're an educator, please login first and then APPLY FOR YOUR EDUCATOR UPGRADE.

Spread the word! Tell your friends to join you in the Diigo education community. Email a colleague! Post to twitter!

13. The Diigo Sidebar

The Diigo Toolbar

Show or hide the diigo sidebar

Bookmark + E-’r Highlight » ) Comment - Lﬂ Send '_-| Message (4) ? Options
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14. My Bookmarks Tab

The My Bookmarks tab shows your most recent bookmarks.

-~

Diigo Sidebar <] a® delicio.us/network/lizbdavis & | @ Web 2.0 for the Classroom Tea... € |
My Bookmarks | 1his URL | Friends -
Tags / Lists / Search

tag1 tag2 tag3 Filtar ‘

My Bookmarks |
= Creating a Ning Network - Google
Docs about 16 hours ago

¥

‘Welcome to Route 21 on
2008B-05-11

Pecha Kucha: Get to the

PowerPoint in 20 Slides Then 5it
the Hell Down on 2008-05-11

Web 2.0 In The Classroom
Presentation on 2008-05-11 &

Web 2.0 | EDUCAUSE CONNECT
[Term View] on 2008-05-11

15. This URL tab

This URL tab shows other diigo readers of this page and
their most recent bookmarks.

—

Diigo Sidebar w®  delicio.us/network/lizbdavis @ | @ web 2.0 for |

4 Web 2.0 for the Classreom Teach . 1. .
+ i new g Click the x to
|| Resdes | amewiens | close the sidebar

|2 22 Readers for this page wore s [f

|@Jo Mcleay
| Recent bookmark: 41 minutes ago

| Cognitive surpius - that's what | had (unbl |

@Ynakanishi047 Nakanishi
Recent bookmark: on 2008-05-07
Greenwich Arts Council - Classes

|@Cindy Brock
JRecent boakmark: on 2007-11-19
Moving at the Speed of Creativity

H. Laura Deisley
=== Recent bookmark: on 2008-04-20
smallstanes = home

| @ Britt Watwood
cent boakmark: on 200 o 5
L 25 | sceroll down to see readers of this
i it Webslte (not just this page on the
Website)
=] 202 Readers of www.kn.pacbell.co

At bookmark: 41 minutes ago
itive susplus - that's what | had funtl |

@] Barney
|2 |Recent bookmark: about  hours ago
Awalk in the Woods
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16. Annotations Tab

The annotations tab under this URL shows what others
have written about this page. It will also show what
others have highlighted on the page, or if others have added a

sticky note.
My Bccl.l".al'l-.sIThis URLII riends
< Web 2.0 for the Classroom TegCh
i et o0 1 Web 2.0 for
Readers Annotations An Ini
crea

Introduction | Blog-Podcast-Viog-Sc
roductivity/Organization Tools | Online Te:

Leng list of links for Web 2.0 and start readin
teaching, sorted by category and wi
brief descriptions
=l Highlights & Sticky Notes 2
Introduction
2 The lalem bl -~ -, : R N L

17. Diigo menu - My Dashboard

Click here for your diigo menu

177 i Diigo * €4 Bookmark - @ Highlight - Comment
Coog  Sign out (lizbdavis) Pw B B
Digo  This URL P> | g® delicio.us/nem
s —

:22; L‘Ei‘.‘l! Iagrz s My Dashboard »

: 3 My Bookmarks »

Is your | My Lists »

homebase My Groups »

on Diigo -Q Friends and Contacts »
i ¥ )

Friends' Bookmarks >

Watchlist » Introducti
Recommended Bookmarks » Productivity/Orgal

Hot Bookmarks »

a

&' Import My Bookmarks...

! T Options... - |

o e Introduction
4, Invite Friends » The links below a
Help » teacher. (Disclaim
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18. Understanding your Dashboard

| Your dashboard has many of the same links as the tool bar.

d“'!j_qo Message (§) Friends¥ Mest People¥ Communities¥ Discovery

My Dashboard My Bookmarks | MyLists | MyTags | My Sites | My Group! e
Click here or here to read
your messages

» My Dashboard

This is where you will find your most recent bookmarks
and your friends most recent bookmarks.

# Recent Bookmarks - =

My Recent Bookmarks (

* Creating a Ning Network - Google Docs Ning, howts

= 4 unread messages

specially shared with me
My Diigo Tools
® My Account

utorial, Tutorials

* Welcome to Route 21 21steenturyskills, educatiogg®veb2.0, resourc Liz Davis
Click here to see [ . View My Proflie
Pecha Kucha: Get to the PowerPoint in 20 S|#s Then Sit the Hell Do bookmarks shared = =
it my profile
pechakucha, powerpoint with you by your r ) La
2 A | Edit my picture
+ Web 2.0 In The Classroom Present: professional_development]  friends. L=
« Web 2.0 | EDUCAUSE CON/ [Term View] web2.0, presentation, tsp
Friends’ Recent Bookmarks more » vits YougErende)
+ Cognitive surplus - that’s what I had (until I started writing this blog!) « Lucacept - intercepting Adding friends will enable you to have
the Web lucacept, clay_shirky , cognitive_surplus Jo McLeay more meaningful knowledge sharing
R R and interaction, Invite friends »

19. Adding bookmarks to Diigo

[[% i Dilgo v ¢  Bookmar

[ Highlight = () Comment = [ Send v () Message (4 T Options

Google :l CM' P v B B 6606 _ ~ Edit your Bookmark on Diigo

Click here to bookmark a Website

'hnp:,’/www.zrlslcen(urysi’(\\lsmg!rm’.ﬂez 1/index.php I

Welcome to Route 21

The Edit Bookmark
window will pop up.

[ Private | Unread [ Twitter this!

" Resources on Web 2.0 tools for the 2 Lst century

You can share the bookmark

You can make the bookmark on Twitter

private or public

21stcenturyskills education web2.0 resources edtech tsp

The Partnership for 21st Century Skills is |
one-stop-shop for 21st century skills-relat

what's new
mmended tags

education m technology  [[LILINIY
curiewiom [ tbrary
resources

recently added
1577 ber ” B i
e I Add the bookmark to a list [ Add0 2t

{ Share with Friends

NEWS &
ANNOUNCEMENTS

| Add a description and tags

Share to a Group already shared to: educators

e pEEE) it

Click Save and Send to email the bookmark to someone

Share your bookmark with
friends or a group

Click Save when done
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20. Highlighting and annotating on
Webpages.

Highlight a section of the Webpage and then click the Highlight link on your
Diigo toolbar. You have the choice of Highlighting a selection or Highlighting
and adding a Comment.

Ty i-i Diigo * &# Bookmark + "[5f Highlight =~ & Comment * [Zg#end + [J Message (4) § Options

Google :] G| sears N B w
©  Highlight and Comment |
Diigo Sidebar hedll:) flizbdavis & €3  Learning and Innovation Skills &

v [ €% Bookmarks v “§ Autolink

INy BcckmalksIThls uRI.IFnem:s Don't Show Highlight Login | MyProfile | AboutUs | Search Materials

&' Learning and Innovation Skills “ached
hutp:/ fwwew. 2 1stcenturyskills.org/route2 1/ index.p
My Tags:

Readers Annotations

: All Annotatlons

Diigo will highlight the selection
in yellow. When other Diigo users
come to this page they will see your
highlight and your comment.

=] Page Comments

Add Comment

| Public -l

his is a key slalement about why 21st
ntury skils are essential for students today.

=
Learning and innovation s increasingly are
Type your comment here being recognized as the sKills that separate
students who are prepared for increasingly
I complex life and work environments in the
oK Cancel 21st century, and those who are not. A focus
| on creativity, critical thinking, communication
and collaboration is essential to prepare
Click OK when you are done. students for the future.

=) Highlights & Sticky Notes ] CFEEtiVit}I’ & Innovation

e

21. Adding comments to Webpages.

Click the Comment link on the Diigo Toolbar to add a Comment on the whole page or
a floating sticky note to the page.

[4 i Diigo ~ & Bookmark = [B Highlight Comment » | Send = J Mes ) F Options

Google [ :] Gl search + 4 52 W Comment on the whole pa tmarks * % AutoLink AutoFill (e Send
= % = Add a floating sticky note to this page

Diigo Sidebar DX .l 9 g nd Innovation Skills & | j-i People who bool

My Bc:km:\LsIYhL! I.IRLIIrIeI‘::s- Login | MyProfile | AboutUs | Search Materials

= Learning and Innova

My Tags: Click here for the dro;_: down comment menu.  fese Ztas Cantn R T
readers | YOU can make your sticky note public skills Support Systems 215t Century skills

or private, add it to a group or a list.

(5
) Page C(=) (floating sticky note) — —
B oL Rdiicamnen This comment bubble indicates .
- [Private there is a comment on the page | Vatlon
This You can move this comment bubble
:ﬂ'; around on the page. 1
\ T T I T R L T e
=] Highligl being recognized as the skills that separate o .
EhL o students who are prepared for increasingly 21ST CENTURY F
[# Learnir complex life and work environments in the il
: Add the text for your Ot || Cancol | 21st century, and those who are not. A focus
3 on creativity, critical thinking, communication
k= (fioatin, 5tICkY note here. and collaboration is essential to prepare
b students for the future,
,! oL =
- C|1C|'<10K when you Creativity & Innovation P
= are done.
arar = Demonstrating originality and
inventiveness in work
I=) (fioatiny - g e

= Developing, implementing and
Baecwnrd communicating new ideas to others
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22. Sending links via email.

Click to Send to Email friends

- Q Send ¥ [_/J Message (4) 'i" Options

You can also
post a note to to Email and Diigo Friends....

; 1 Post a Note...
your Blog, Twitter } to Blog » t
to Twitter... I

Ei to Facebook...

or Facebook accounts

You will have to set these up first using the tools menu

23. Messaging on Diigo

“eacher TinyURL! blog stats WHS WEbsite Twitter Diigolet Shar - mbl'n teachers Read Later u
i Digo » <4 Bookmark » [B Highlight * ) Comment » [ Send @ Options

: T] (G Search ~ e B- - M-8 w m— gkmarks * 4 Autolink '
SO The messages tab indicates that a diigo friend o (N
has sent you a message.

Q My Messages Pusiia View
...

fome - My Messages

senacemernstionf yay can send messages to all of your
friends, or click the drop down menu to
send to individual people.

Send to: [ Al my friends #

. =

f

Click here to see all of the messages on a topic i B0 oreas (HEE

Topics Posts | Vists tarted by Latest by
. Have you had friend rgquestﬁllkem-‘\ 301 18 Lucy Gray aggi

chael Baker

I Click here to see the latest message on a topic l e
S—
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24. Diigo toolbar options.

Click options to change
your toolbar options

i SIBIATr S ore | [ You can also adjust your Bookmark and Highlight
i, r-s\ Options options and your Keyboard shortcuts.

P&  Rankmarks v & j !
‘ Toolbar and Menus !' Bookmark and Highlight | Keyboard ]

Context Menu and Content Selection Menu

NotFeanicianoe ¥ Dilgo buttons at the top of the context
the number of | ligo buttans at the top of the context menu
buttons on your / ] Show drop-down menu when text is selected
toolbar, and |
how they
are displayed. I B righlight. ¥ & send |
#® Comment [ g, search

W) Message [ T Options

Select Toolbar Buttons |

Toolbar Button Text Labels

® Show icons and text

() show icons

( Apply Suggested Settings ) (" cancel )

A
Z

-

Apply your settings and then click OK

25. Find people like you on Diigo

Another way to

find friends

on Diigo.

Choose Meet People
and click on

o i L People Like Me

Poaple Online Now

Pecple Like Me: mstching basad on recent boskmarics

»
6% 7% H 7%
@lindiay o Region: Arlzona \uum:uu city: rmTla @:Lyn;lec“lc City: Hamiltan

Diigo will find people who have share bookmarks with

L you. You can click on their links and invite them to be
your friend on Diigo.

P ‘ i
1 6%./ a 6‘% \ B 6%

@ ko Oha | Region: Wisconsin
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26. Join groups on Diigo

You can join groups in Diigo and share bookmarks, have discussions
and add friends with similar interests.

di-lqo Homey Memmaaidl Franéry  Wempoopicr [

v bets

[3
Site Comemanities | Tag Comamunities
Brors - She Cammunkies
Tag Cammunkies
Diigo Groups provides & ground-treaking colabaralive reseantiles at aliows any group of people 1o pool thesr findings tvough group
bookmarks, highlights, sticky notes, and forum.
Share knowledge Join discussion Make new friends

Expiore O -

] rm)’ou-ca n-search-for-groups.-by key-words-or categories- } —

5.® Search |

» Business & Finance » Computers & Internet
« Cultures & Community [ 19 . Entertainment & Arts
. Family & Home . Games

. Government & Peiitics | 74 . Health & Wellness,

. Collaeting & Hobbies | 4 . Musie

. Recreation & Sports | 5 . Rei

.« Romance & Relstionships . Schools & Education

Seiance
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How to Create a Ning Network
http://www.ning.com

Home [ i il

Liz B. Davis ~ May 11, 2008
Updated Nov 21, 2008

&8

. Create your network

g Sign Up or SignIn / Popular Social Networks

Pick a name for your network, this could be anything

Create Your Own Social Netwgrk for Anything

Name Your Social Network  Computer Applications 2008

Pick a Web Address DavisCompApps08 .ning.com CREATE

Pick a Web Address - this is what the students will type in to get to the site.

. Shorter is better, but there is a 6 letter minimum, and your name may already be
Ningl  taken,

Here arg

ISeeColor 13 The Musical Fansite

Frantod R Reviedon Madin fram Tha Affirial Plara far Fane nf 13 Tha Musical Mrantad hi Mishaol
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2. Sign up for a Ning account

Fill in your email address (this will be your log in ID)

Students should use their first name only

Get a Ning ID Account

Already have an account? Sign in here.

Email Address Myemail@here.com

\ Name First Name only for kids
Password ======

Copy the letters | Retype Password j=e==
that you see. Type the Code

h‘ on the Right trrGN

Choose a password

tl‘l‘(‘N

By signing up, you agree to the Terms
of Service and Privacy Policy.

Click to sign up Slon Un

when you are done lems signing up?

3. Add your network information

e
Nl n g' Describe Your Social Network Launchl o [

s - - 5 - = rivate or
All of this information, including the privacy level, can be changed at any fime I

Features

etwork Name | Computer Application 2008
Cheoose a privacy level
for your network. "* Privacy ® public - Anybody can see or join it

— Private - Only invited people can join and see it

Tagline | A place to share our ideas and resources.
Add information about jr Appears in the header of your network
your network here,

Description | We will use this space to reflect on what we learn in class, share the

\ resources we find, and discuss ideas and issues that come up.

Keywords help people Up t0 240 charasters (8 lof)
search for your network. \

Keywords | Technology Web2.0

Separate each keyword with a comma

Networks can be Language |English (U.S.) -|

created in a variety
of languages.

Click next when o xf
you are done.
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4. Add features to your network

Add Features to Your Network Launchl or m

Choose the features you want for your new social network by dragging features from the list on
the left to the homepage layout on the right.

b Features Layout
| Activity shows what the members of the
" By Photos Computer Appli
Click here to o network have done recently.
view more B Events 7
features.  [™ View all features = Description Activity ’2 Forum is the discussion
& Members 3 Forum / feature.
Drag Here to Remove ]
Feature P
e L S \ You can create sub-groups|
Drag features here Blog within yoeur network
to remove them. \ T
» .

Click and drag the features you want to the layout. |/ You can feature member's bleg
You can rearrange them here as well, posts on the front page of the
network.

@ Click Next when P
you are done.

5. Choose a theme for your network.

CuStomj’ze Appearance Launch your networkl

Make your new social network stand out from the crowd by choosing a theme and customizing it below.

Choose a theme for your network

First, choose a theme

Office Cheesecake

Soft Melon Ocean Winter Martini
Metwork Name Metwork Name Network Name fotveork Name Network Name MNatwork Name
Hendi Heading Haadi Haading Handi Haading Handi Hending Haudi Haading Heondi|
Terracotta Pistachio Rouge Igy eam Snow Sunshine Espresso
Network Name . 8 a Network Name % Metwork Namd Metwork Mame
3
———— :
il ading i Heading Headi! Heading Foas

Now, make it uniquely yours

Theme Settings | Advanced

Fante
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6. What you can do on ning.

View the Main Page Jur

Main - Invite MyPage Members Photos

d photos and videos
Create groups Manage network options
Videos Forum Groups Blogs Manage
— - P Read member bl
Customize your page i Start and read discussions 8 ead member Dlogs B mavie
2 b e n O

‘we learn In class, share the resources we Davis! 7
find, and discuss ideas and Issues that " 4

Here are a few things you can do right now. .
‘come up.

B Inbox

@ Alerts

% Friends - Invite
¥ Settings

Quick Add...

Ads by Google

A B B w

7/

Add avideo Staria discussion Make it unique

Members

Invite friends Add photos

Latest Activity

+ Invite More

Videos

See directions for
how to remove the

ads for educator
‘Computer Application 2008 now has biog

‘You created the Computer Application 20

Create Your Own
Layout

100% Free Backgrounds
& Layouts Download and
Creaie Your Own Freel

spaces, Myspacs.CreateYourFreelayout.c

‘Computer Application 2008 now has groups Pimp Your Pas
Custom Layouts &
Backgrounds fo choose -

Computer Application 2008 now has a forum Thosmlond Ths Nead

7. Start a discussion

Forum Home My Discussions

Title your discussion

Start a New Discussion

pELTUL R E Coogle Documents

Post: B 7 U S B

You can work on your document anywhere you have an Internet connection. Two
people can simultaneously work on the same document. You can easily publish any
document to the Web.

Enter you
question,
you can add
links and
images.

Using <a href="http://docs.google.com/Doc?id=dfnmfqtd_342fqgB8g269">these
directions </a>(created using Google Docs), try Google Documents.

After you have tried it, let us know what you think.
Consider these questions:

Tags: "Google Documents”

stersflizdavis,fDn(ume Lg Browse

Adtach File(s):

Browse...

Click here to post
Sbiusd your discussion question

Upload a file or document with your discussion question

—
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8. Personalize your page.

You can personalize your own page with pictures, text, video and other widgets.

My Page My Friends My Blog # Invite Friends

Latest Activity

You started 2 forum discussions. Vi

A U T
21st Century Tools for Learni oW he £0S 6

What grade level and or subject do you teach?
Elizabeth Davis 9-12 TV/Video and Instructional Technology

40, Female
Sree Where do you teach?

Wellesley School, Wellesley, MA

Describe your comfort level with technology
Very comfortable

Network Creators can manage their network.

Hello, Elizabeth Davis (Sign Out)

e ®

Invite Friends Broadcast Latest Activity Badges & Facebook

Ay Widgats oA Add Web tracking code to analyze

your network traffic

==
= \ L ¢
Tab Manager  Language Editor Analytics Premium Flickr Importing

Promete members to administrators
or ban a member from the network

Change the titles on the tabs
for example, change “forum" to
Q “discussion."

Members Privacy &
Featurs Gontrols hange the privacy levels
]

for your members to
answer when they jo

e B

Create a New Network Help Center Developer
Network Creators Network

# Online - Network can be viewed with respect to your privacy ssttings. (Take Offline) ¢ Delete Network
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10. Edit the profile questions.

Profile Questions

What questions would you like your members to answer when they join your network?

Default Questions
‘You can choose to keep these questions, or write your own questions below.

ck the boxes to remove these
questions. There are many

different types of
questions.

To re-order the questions, click on a question and drag it to where you want it to appear. If v~ . select 'required
have to answer the question to join; if you select private', the answer will only be visi*’  to you and other administrators.

Question Title You can mark a question
private, so only you
can see the answer.

Answer Type  One Line Answer d | O Required ) Private 2

You can #Remove 4 Add Another Question

add or
remove You can make
questions. some questions
required in order
Choices [ can pick more than one to J'Diﬂ the network.
Separate each choice with a comma

Multiple Choice | O Required [ Private &

#Bemove HF Add Another Question

11. Change privacy settings.
Privacy & Content Control

Network Privacy Feature Controls
@ Public B Allow members to create groups
This network is visible to everyone. & Approve new members before they can join
Anyone can sign up to become a member. Visitors
can...
See everything Make networks
# See just the main page public or private.

B Allow members to create events

Bl Approve photos and videos before they appear
Il Enable Music Player download links

® Private
This network is visible to members only.
Who can sign up to become a member?

Py network:
it http://21ctools.ning.com/7xgi=354fpVb
@ Only Invited People
Create New Invitation Link

Invite new members

Invitations
Share this link with people you want to join this
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12. Manage your members:

MEI‘I'lef'S Additional administrators can be added.

Members (1) Mminisiri&‘—
Demote from Administrator | Ban from Network _ Show All

Administrators have a similar level of control to the Network Creator.
I ] Name Email Status Date Joined
[ Ellzabeth Davis eblelch@yahoo.com # Network Creator May. 11,2008

- Invite More People

Members can be banned from the network ¥ Export All Member Data (CSV)

13. Ning Resources for educators

e Directions for how to remove ads on
educator networks: http://tinyurl.
com/22cwdc

e Network for learning about Web 2.0
tools: http://www.classroom20.com/

e Network for people using ning in
education: http://education.ning.com/
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Getting Started with
Flickr.
http://www.flickr.com

Created by Liz B. Davis
May 11, 2008

@00

1. Create an account or start searching

Click here to Create your Account

\ Sign In
Create Your Account
Only takes a moment with your Yahoa! 1D

Share your photos.“:"w‘%
Watch the world.

You can search for photos without having an account.

7




2. Sign up for a Yahoo account

If you have

a yahoo
account you
can use that
to sign up for
flickr.

If you don't

Sign in to Yahoo!

(Why?)

\ Yahoo! ID: |

Password: ,

[+ Keep me signed in

Are you protected?
Create your sign-in seal.

for 2 weeks unless | sign out. Ll
[Uncheck if on a shared computer]

Forget your ID or password? | Help

Sign In

have a yahoo
account you will
need to sign up
for one

Don't have a Yahoo! ID?

Signing up is easy.

m———)» Sion Up

3. Sign up for a Yahoo account (part 2)

1. Tell us about yourself

[ram Bryaer

2. Select an 1D and password

2 tSprotdevayance. com

[ v remd andagrae ta i Vsl Terms of Serves and Yanoal Prbacy Palicy. asd 1o secehe Impariadlcan m rkcatiars fxam Yanoo!

alacisankcalky.

0

Enter your information

Prove you are human (not spam).

account

Click to create your

Far yaur cameeskence. v dacumants will be @malied ia yae Yahaal Uallsoraas

Create My Actour
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4. Your Flickr account name can be
different from your Yahoo account.

Welcome back! if you don't want to use your
yahoo ID you can change
Make a new Flickr account your Flickr screen name.

Choose your new FlicW
::Tsprofde\.r Z

This can be different from your Yahoo! ID, you
can change it later, and spaces are fine.

Yahoo!
Terms of Service Privacy Policy.

CREATE A NEW ACCOUNT |

5. Check your email to activate your
account. Look in the bulk folder if you
don't see it in your inbox.

You will receive an activation email. You must click the link
to activate your account.

my-yahoo-register@yahoo-inc.com to me 9:24 AM (1 minute ago) Reply
Y HOO' Yahoo! - Help
A .

Do not reply to this message. If you did not crefjte an account, please follow the instructions at the
end of s email.
Welcome to Yahoo!
Click the link below to verify your email address activate your account. Email verification helps
protect your identity and allows you to participate¥eafely on all of Yahoo!'s properties.
Important! Click here to activate your new account.

Four Yahoo! ID and Email:tsprofdev@yahoo.com

Your alternate email: et .

If you can't click on the sentence labeled "Important!" above, you can also verify your email address
by cutting and pasting (or typing) the following address into your browser:

https://edit.vahoo.com/v/recy ?cf21d5&.intl=us

For your records, your verification code is: cf21d5
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6. Use the advanced search to find
copyright friendly images.

To find images click on the word search.

" Search

Eind out wt

Search Photos  Groups  People Choose Advanced Search \

Everyone's Uploads - [ - Advanced Search
2 " - SEARGH Search by Camera

7. Creative Commons images are free to
use with attribution

Advanced Search [ Enter your search term(s).\

Search for All of these words bl |

I Scroll down on the page. I

Check off the Creative Commons box to find images that are
free to use (with attribution).

@gisative I~

OMMons ~| Only search within Creative Commons-licensed content

" Find content to use commercially
Leamn more... I Find content to madify, adapt, or build upan

Click Search SEARCH

Or, return to the basic search without all the knobs and twiddly bits.
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How to Create
a

VoiceThread
http://www.voicethread.com

Created by Liz B. Davis
May 11, 2008

@00

1. Register for an account. (part 2)

Register for an account with voicethread

“voicethread

What's G N VIDEO
NoiceThread? CPOtlﬂeNTINEG DOODLING

Browse Create MyVoi

o REMOTE
N\ _..-‘) R <
V4 T\ N
Presentations  Classroom Featured Travel  StoryTelling  Family
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2. Reqister for an account (part 1)

Register for VoiceThread

names:

email:

retype email:

password:

retype password:

Registering indicates you accept our Terms of Use.

Already have an account? Sign in.

3. Learn about Ed. VoiceThread

Sign in or Register

Browse Create MyVoice VOlcethread

. o
Uimedt (7)) DO

o Going and
oG an
4 enn : -~ :
: . AWy
Click on the Classroom Tab to learn more about Ed. VoiceThread

L
Presentations Classroom Travel StoryTelling Family

April 22nd 2008: VoiceThread = Webware 100 winner! - Read more.

@ Ed.VoiceThread.com is a secure collaborative network designed for

the K-12 academic environment. Using one simple tool, educators and \_.J @ 0 Q

students can collaborate around almost any type of media via voice, text,
webcam and drawing commentary, all within a secure environment. Access

to the network is restricted to K-12 educators, students and administrators, Learn See it ;
ensuring safe and secure classroom collabaration More in action!
I Click to learn more V
Home ' About Pricing Press Blog Help  Contact Us Copyright © VoiceThread 2007-08 - Terms of Use
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4. Click on the Help tab and watch the
VoiceThread tutorials.

Help & |, } v voicethread

FAQ
Forum
Tutorials

5. Explore VoiceThread examples

I Click on the Browse Tab to see examples of VoiceThreads l

]
erowse: [IIINIEGNG Create MyVoice

M SRR ] Search a particular VoiceThread topic

Pl

3 v
igita : Top § Cartoon Cllck the arrows to advance to the
Storytelling Themes next set of examples.

« @GE» »
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6. Create your own VoiceThread

Browse Create MyVoice

Click the Create tab to create a new VoiceThread

1. Upload O

Upload images, docs and videos by
using the buttons on the left.

From My Compu ‘ «

Flickr facebook

Click on Upload. You can upload images,
powerpoints and documents from your
computer and/or from Online sources.

/. Select your first image.

Browse Create MyVoice
About VoiceThread How to create a voice thread  EditTile  Delete Thread &

1. Upload o

From My Computer
D e

oy eoin  ome |
Selectianiimage)
2. Comment

3. Share @m@@@ﬂ@

Options

\Youlcanisharejthelimagesiwithout{commenting’;

Export

Clickitolrotatelthelimage]

Clickitoladdlaltitlefandlallinkiforithelimage

(add a title and link) (Glickitheltrashfcanitoldiscardithelimage;
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8. Add an audio, video or text comment

mr.: hread®  COMMENTING

] ) REMOTE
- (ONTROL

- Use a Webcam to record a comment _

;'] ° @ (D) CGET™ O
‘.'_:‘ o

record an audio commentary Add a written comment

9. VoiceThread Options

1. Upload

2. Comment

3. Share Set Options for the

VoiceThread
Options

Export Embed

Set Options for this VoiceThread

Wait E- seconds before turning the page.
Start playing when opened? Yes

Show fullscreen when opened?

Allow others to download original
images and documents?

Hide final share page?

Allow others to Export?
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10. Choose your Sharing Options

Choose the sharing options

Comment moderation options

Sharing Options

This VoiceThread is: Comment Moderation:

Private &~ Off -

Private off
Public, no comments on
Public, yes comments

11. Embed or share your VoiceThread

Embed this VoiceThread

|'CI—‘| iGoogle 4 MySpace i; Friendster n Facehook

orkut ® B &) Tazzed £ Bou=
Copy and paste o i
thepzmbedpcode hify Hi3 #58 Live Spaccs P Piczo Q Livoumal
onto a blog or /g BlackPlanct Vo A My #lo Papcllakes
other Website. © MiGme iy Commen [0, Frocwets @ myYembook

E TypePad x' Xanga Netvibes
Or copy eode:

ttp: // voicethread.com/ share/131165/ Copy this

Share the Online link
to your Voicethread
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